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Основы черчения в AutoCAD



План лекции

• Структура курса. История создания и 
развития системы AutoCAD 

• Палитры основных инструментов.
• Сетка и привязка к ней.
• Системы координат.
• Редактирование с помощью ручек.
• Удаление, перемещение, 

копирование, поворот объектов.
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История создания и развития 
системы AutoCAD

AutoCAD — программа с богатой и во многом 
уникальной историей. Впервые она увидела 
свет в 1982 году под именем MicroCAD. Сегодня 
AutoCAD переводится на 18 языков мира. 
AutoCAD — это наиболее гибкая из 
существующих графическая программная 
система для ПК, способная эффективно 
работать в самых различных областях 
технического проектирования. 
AutoCAD сейчас используется более чем в 150 
странах мира.



Строка меню
1. File (Файл) — команды работы с файлами: создание, открытие, 

сохранение, печать, экспорт файлов в другие форматы и пр.;
2. Edit (Правка) — инструменты для редактирования частей графического 

поля Рабочего стола программы, работы с буфером обмена;
3. View (Вид) — команды управления экраном, панорамирования, 

установки точки зрения, удаления невидимых линий, закраски, 
тонирования, управления параметрами дисплея; установка необходимых 
панелей инструментов;

4. Insert (Вставка) — команды вставки блоков, внешних объектов, объектов 
других приложений;

5. Format (Формат) — команды работы со слоями, цветом, типами линий; 
управления стилем текста, размеров, видом маркера точки, стилем 
мультилинии; установки единиц измерения, границ чертежа;

6. Tools (Сервис) — средства управления системой, экраном пользователя; 
установки параметров черчения и привязок с помощью диалоговых окон; 
работы с пользовательской системой координат;

7. Draw (Рисование) — команды рисования;
8. Dimension (Размеры) — команды простановки размеров и управления 

параметрами размеров;
9. Modify (Редакт) — команды редактирования элементов чертежа;

10. Window (Окно) — многооконный режим работы с чертежами;
11. Help (Справка) — вывод на экран системы гипертекстовых подсказок.



Командная строка

Нижняя (светлая) часть экрана, в которой вы 
видите приглашение в форме Command: 
(Команда:), — это область, через которую в 
основном происходит диалог пользователя с 
системой, здесь отображаются вводимые вами 
команды и ответы (или вопросы) AutoCAD. Эту 
часть будем называть зоной командных 
строк. Последняя строка, содержащая 
приглашение Command: (Команда:), называется 
командной строкой.



Строка режимов
1. SNAP (ШАГ) — Snap Mode, включение и выключение 

шаговой привязки курсора;
2. GRID (СЕТКА) — Grid Display, включение и выключение 

отображения сетки;
3. ORTHO (OPTO) — Ortho Mode, включение и выключение 

ортогонального режима;
4. POLAR (ОТС-ПОЛЯР) — Polar Tracking, включение и 

выключение режима полярного отслеживания;
5. OSNAP (ПРИВЯЗКА) — Object Snap, включение и 

выключение режимов объектной привязки;
6. OTRACK (ОТС-ПРИВ) — Object Snap Tracking, включение 

и выключение режима отслеживания при объектной 
привязке;

7. LWT (ВЕС) — Show/Hide Lineweight , включение и 
выключение режима отображения линий в соответствии с 
весами (толщинами);

8. MODEL/PAPER (МОДЕЛЬ/ЛИСТ) — Model or Paper space, 
переключение из пространства модели в пространство 
листа.



Основные панели

Все панели имеют имена. Под строкой 
меню видны две горизонтальные панели 
с наименованиями: Standard Toolbar 
(Стандартная) и Object Properties 
(Свойства объектов). Эти панели 
желательно не трогать, не удалять и не 
перемещать, поскольку они постоянно 
нужны для работы. Две вертикально 
расположенные панели называются Draw 
(Рисование) и Modify (Редактирование).



Функциональные клавиши
• F1 — вызов справочной системы AutoCAD;
• F2 — переключение между текстовым и графическим окнами;
• F3 или Ctrl+F — включение/отключение текущих режимов 

объектной привязки OS NAP;
• F4 — переключение системной переменной TABMODE;
• F5 или Ctrl+E — циклическое переключение изометрических 

плоскостей;
• F6 или Ctrl+D — включение/отключение отображения текущих 

координат курсора в строке состояния;
• F7 или Ctrl+G — включение/отключение отображения сетки 

GRID;
• F8 или Ctrl+L — включение/отключение ортогонального режима 

ORTHO;
• F9 или Ctrl+B — включение/отключение шаговой привязки 

SNAP;
• F10 — включение/отключение режима полярного отслеживания 

POLAR;
• F11 — включение/отключение режима объектного отслеживания 

OTRACK;



• Esc или Ctrl+[, Ctrl+\ — прерывание текущей операции;
• Enter, Ctrl+M или Ctrl+J — повторение последней команды;
• Ctrl+A — включение и отключение выбора группы объектов;
• Ctrl+C — копирование объектов в буфер обмена Windows;
• Ctrl+N — открытие диалогового окна создания нового рисунка 

Create New Drawing;
• Ctrl+О — открытие диалогового окна выбора ранее созданного 

чертежа Select Fi le;
• Ctrl+P — открытие диалогового окна вывода чертежа на печать 

Plot — Model;
• Ctrl+R — смена видового журнала;
• Ctrl+S — сохранение текущего рисунка;
• Ctrl+V — вставка объектов из буфера обмена данных в текущий 

чертеж;
• Ctrl+X — удаление выбранных объектов из чертежа и 

копирование их в буфер обмена данными;
• Ctrl+Y — восстановление только что отмененного действия;
• Ctrl+Z — отмена последней команды.



Определение границ рисунка
Границы рисунка — это пара двумерных 

точек в мировой системе координат: 
координаты левого нижнего и правого верхнего 
углов, определяющие прямоугольную область. 
По оси Z границы не устанавливаются.
В AutoCAD границы рисунка выполняют 

три функции:
1.определяют диапазон изменения координат 

точек;
2.контролируют фрагмент рисунка, покрытый 

видимой координатной сеткой;
3.определяют, какая часть рисунка 

отображается на экране по команде ZOOM 
ALL.



Запросы команды LIMITS 
Reset Model space limits :—переустановка лимитов 
пространства модели;
Specify lower left corner or [ON/OFF] <current>: — 
указание левого нижнего угла;
Specify upper right corner <current>:— указание 
правого верхнего угла, где:

•ON — включается контроль соблюдения границ. При 
этом AutoCAD отвергает все попытки ввести точки с 
координатами, выходящими за границы рисунка;

•OFF — отключается контроль соблюдения границ 
рисунка;

•<current> — задается новое текущее значение левого 
нижнего, а затем правого верхнего угла.
Если текущее значение границ рисунка вас устраивает, 
достаточно нажать клавишу Enter.



Определение параметров сетки
Сеткой (GRID) называется упорядоченная 

последовательность точек, покрывающих 
область рисунка в пределах лимитов.
Использование сетки помогает выравнивать 

объекты и оценивать расстояние между ними. 
Сетку можно включать и отключать в ходе 
выполнения других команд. На печать она не 
выводится.
Включение сетки и определение ее частоты 

осуществляется на вкладке Snap and Grid 
диалогового окна режимов рисования Drafting 
Settings.



Определение шага привязки
В режиме шаговой привязки SNAP курсор может 

находиться только в определенных точках согласно 
установленному значению шага и при этом движется не 
плавно, а скачкообразно между узлами воображаемой 
сетки, как бы «прилипая» к ее узлам. 

Шаг привязки не обязательно совпадает с частотой 
сетки. Сетку часто делают достаточно редкой, 
используя ее исключительно для наглядности, а шаг 
привязки устанавливают меньшим. Допустимо и 
обратное: установка большего по сравнению с сеткой 
шага привязки.

Включение шаговой привязки SNAP и настройка ее 
параметров осуществляются на вкладке Snap and Grid 
диалогового окна режимов рисования Drafting Settings 



Сохранение рисунков
Команды SAVE и SAVEAS предназначены для 
сохранения рисунка под другим именем. Команда 
SAVE может вызываться только из командной 
строки, a SAVEAS — из падающего меню File > Save 
As.... В обоих случаях имя документа задается в 
поле File name: диалогового окна Save Drawing As.
Для чтения сохраняемого файла в различных 
версиях AutoCAD необходимо в 
раскрывающемся списке Files of type: 
диалогового окна SaveDrawingAs выбрать 
пункт 
AutoCAD 2007/LT2007 Drawing (*.dwg )



Системы координат
Ввод координат
Введение координат в AutoCAD  осуществляется двумя 

способами:
• Непосредственно с клавиатуры путем задания 

численных значений;
• С использованием курсора, который перемещается по 

экрану.
В строке состояния происходит отображение текущих 

координат.
Для удобства ввода координат можно испльзовать:
• Орто-режим, если изменение координат происходит 

только по осям Х или Y. Орто-режим устанавливается 
или функциональной клавишей F8, или щелчком мыши 
по кнопке ORTHO(ОРТО) в информационной строке;

• Привязку к узлам невидимой сетки, которая задаётся с 
некоторым шагом по Х и Y.



Декартовы и полярные координаты
Ввод абсолютных координат производится в следующих 

форматах:
• Декартовы(прямоугольные) координаты. Ввод 

заключается в задании расстояния от точки до начала 
координат по любой из осей, а также направления (+ 
или -);

• Полярных координат. При этом ввод координат 
заключается в задании расстояния, на котором 
располагается точка от начала координат, а также 
величины угла между полярной осью и отрезком, 
который мысленно проведен через данную точку и 
начало координат. Угол задается в градусах против 
часовой стрелки. Значение 0 отвечает положительному 
направлению оси ОХ.

Относительные координаты задают смещение от 
последней точки. При вводе точек в относительных 
координатах можно использовать любой формат записи 
в абсолютных координатах: @dx,dy для декартовых, 
@r<A для полярных.



Редактирование с помощью «ручек»
Выбранными объектами можно манипулировать с помощью ручек — 

маленьких квадратиков, которые высвечиваются в определяющих 
точках выбранных объектов.

При включенном режиме работы с ручками выбор объектов производится 
до редактирования, а манипуляции с ними выполняются с помощью 
указателя мыши или ключевых слов.

• Параметры ручек устанавливаются в следующих областях:
• Grip Size — определяет размер ручек при регулировании движком. 

При этом на экранчике слева от движка показан текущий размер 
ручек;

• Grips — ручки:
– в раскрывающемся списке Unselected grip color: задается цвет 

невыбранных ручек;
– в раскрывающемся списке Selected grip color: задается цвет 

выбранных ручек;
– в раскрывающемся списке Hover grip color: задается цвет ручки 

под указателем мыши;
– установка флажка Enable grips активизирует ручки для всех 

выбранных объектов;
– установка флажка Enable grips within blocks обеспечивает выбор 

объектов с помощью ручек внутри блоков;
– установка флажка Enable grip tips: позволяет задать подсказки к 

ручкам.



Удаление и восстановление объектов
Команда ERASE(УДАЛИТЬ) осуществляет удаление 

(стирание) объектов. Она вызывается из падающего 
меню Modify > Erase или щелчком мыши по 
пиктограмме Erase на панели инструментов Modify.

Запросы команды ERASE:
Select objects: — выбрать объекты;
Select objects: — выбрать объекты;
Select objects : - нажать клавишу Enter для 

завершения работы команды.
Выбор объектов, которые следует стиреть, может 

производиться любым из доступных способов.
Для восстановления удаленных последней командой 

ERASE объектов используется команда OOPS. Ее 
название «ОЙ» весьма удачно отражает эмоции 
пользователя, испытываемые в момент применения 
этой команды.



Перемещение объектов

Команда MOVE осуществляет перемещение 
объектов. Она вызывается из падающего меню Modify 
> Move или щелчком мыши по пиктограмме Move на 
панели инструментов Modify.

Запросы команды MOVE:
Select objects: — выбрать объекты;
Select objects : — нажать клавишу Enter по 

завершении выбора объектов;
Specify base point or displacement:—указать 

базовую точку или перемещение;
Specify second point of displacement or <use first 

point as displacement: — указать новое положение 
базовой точки.



Поворот объектов
Команда ROTATE осуществляет поворот объектов. 

Она вызывается из падающего меню Modify > Rotate 
или щелчком мыши по пиктограмме Rotate на панели 
инструментов Modify.

Запросы команды ROTATE:
Current positive angle in UCS: 

ANGDIR=counterclockwise ANGBASE=0— текущие 
установки отсчета углов в ПСК;

Select objects : — выбрать объекты;
Select objects: — нажать клавишу Enter по 

завершении выбора объектов;
Specify base point: —указать базовую точку 

поворота;
Specify rotation angle or [Reference] : —указать угол 

поворота.



Ключ Reference используется для поворота 
относительно существующего угла. При этом 
выдаются следующие запросы:

Current positive angle in UCS: 
ANGDIR=counterclockwise ANGBASE=0—текущие 
установки отсчета углов в ПСК;

Select objects: — выбрать объекты;
Select objects: — нажать клавишу Enter по завершении 

выбора объектов;
Specify base point: — указать базовую точку поворота;
Specify rotation angle or [Reference]: R — переход в 

режим задания угла со ссылкой;
Specify the reference angle <0>: —указать опорный 

угол;
Specify the new angle: —указать новый угол.



Копирование объектов 
Команда COPY осуществляет копирование объектов. Она 

вызывается из падающего меню Modify > Сору или щелчком 
мыши по пиктограмме Сору на панели инструментов Modify.

Запросы команды СОРУ:
Select obj ects : — выбрать объекты;
Select objects : — нажать клавишу Enter по завершении 

выбора объектов;
Specify base point or displacement, or [Multiple]: — 

указать базовую точку;
Specify second point of displacement or <use first point 

as displacement: — указать положение копии объекта.
Ключ Multiple используется для Создания множества 

копий объектов. При его применении последний запрос, 
требующий указания точки смещения, делается многократно. 
Каждое смещение определяется относительно исходной 
базовой точки. После получения нужного числа копий в ответ 
на запрос необходимо нажать клавишу Enter.


